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Credit Reporting Changes

The following enhancements and changes involve Credit Reporting in GOLDTrak PC:

Enhancements Made to Credit Report Dialog

New Equifax Connection Options

TransUnion TUNA Support Added



Archived - Changes Previous to Version 7.1 5

© 2019, GOLDPoint Systems. All rights reserved. Last updated: 5/13/2019

Enhancements Made to Credit Report Dialog

The following improvements have been made to the Credit Report dialog. (This is the dialog that appears if you

have the <Credit Report> button on select screens.)

· Added the Report Date column to the Existing Reports list control.

· The Existing Reports list control is now automatically sorted by date in descending order.

· All list controls on the dialog are now user-sortable.

· The Credit Scores list control now resizes to fit the screen.
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New Equifax Connection Options

CMF# 7391

The process we used to transfer data to Equifax has changed. This information was previously hard-coded for

each institution. Now we can set up the data to according to each branch or office, and each branch or office

can have its own customer code, site ID, password, and URL address to Equifax. 

In order to do this, we added three fields to the Equifax tab on the Credit Report Setup tab of the

Institution/Office Setup screen in GOLDTrak PC. You may need assistance from your GOLDPoint System

account manager.

See the following example of these new fields:
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TransUnion TUNA Support Added

CMF# 6707

We have added support for the new TransUnion Net Access system, commonly referred to as TUNA 2. New

system IDs, passwords, and URLs are required for this support. Consequently, we have added new fields to

GOLDTrak PC Setup in order for these credit reporting transmissions to work correctly. Additionally we updated

the URL address used to communicate with Trans Union.

In GOLDTrak PC Setup, on the Institution/Office Setup screen, Credit Report Setup tab, then Trans Union tab,

two new fields have been added: TUNA 2 System ID and TUNA 2 Password. For setup purposes, these field

names are known as TU_TUNA2_SYS_ID_IO and TU_TUNA2_SYS_PWD_IO. See the following example of

these fields on the Credit Report Setup tab.

GOLDTrak PC Setup > Institution Setup > Institution/Office Setup Screen, Credit Report Setup Tab, Trans Union

Tab
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Error Corrections

The following errors have been corrected in GOLDTrak PC:

Auto Formulas Option Corrected

Check Detail Dialog Corrected

Keystrokes for SSN/EIN Corrected

Previous Addresses Retained

Printing Error from NADA or KBB Document Corrected

Rounding of Prepaid Fee

Sales Calculations Now Match in GOLDTrak and eGOLDTrak

Security Button Now Hidden in Toolbar
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Auto Formulas Option Corrected

CMF# 6410

A correction has been made to the Options > Auto Formulas menu item in GOLDTrak PC. Previously, if a loan

request had been opened when the Auto Formulas option was turned off, the only formulas that would run were

those flagged as ALWAYS_OK_TO_RUN.

This problem has been corrected. Now when the Auto Formulas option is turned on, all formulas will first be

loaded, and then they will run accordingly.
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Check Detail Dialog Corrected

CMF #6161

The Check Detail dialog has been corrected to never show the AD&D Check checkbox if the Show ADD

Checkbox on Checks Screen option (on the Options tab on the Institution/Office Setup screen in GOLDTrak

PC Setup) is not selected. Previously, the box was always displayed if it wasn't a fee check.

Check Detail dialog displaying the AD&D Check box.

GOLDTrak PC Setup > Institution Setup > Institution/Office Setup screen, Options Tab
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Keystrokes for SSN/EIN Corrected

CMF# 6249

A correction has been made when changing the SSN/EIN field on the Consumer Application screen. A quick tip

when entering Social Security numbers in this field is to press <Ctrl> + <Shift> + S while in the field, and then

type the Social Security number. The system automatically enters the appropriate dashes. However, if entering

an Employee Identification number, the formatting is different, so if you clicked <Ctrl> + <Shift> + E, the system

would change the formatting appropriately. 

One institution found that if they tried this tip, the system would complete the appropriate change, but then it

would bring up the OFAC Search screen instead of staying on the Consumer Application screen. 

This has been corrected.
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Previous Addresses Retained

CMF# 7398

A correction has been made concerning any previous addresses entered on a loan application. Previously, if

information was entered in the previous address fields on the Consumer Application screen in GOLDTrak PC,

and then the user requested the credit file, the system would mistakenly update existing previous addresses

with information from the Credit Report. This had been corrected, so that the system now adds previous

addresses after any existing previous addresses.



Archived - Changes Previous to Version 7.1 13

© 2019, GOLDPoint Systems. All rights reserved. Last updated: 5/13/2019

Printing Error from NADA or KBB Document Corrected

CMF# 6405

When the <Print> button was clicked while previewing a NADA or Kelley Blue Book document, the equipment

would be missing from the printed version, even though it appeared correctly in the preview window. This problem

has been corrected, and the equipment should appear on the printed page exactly as it appears in the preview.
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Rounding of Prepaid Fee

CMF# 31045

When the prepaid fee is based on a percentage, we have always rounded to the nearest penny after doing the

calculation. However, this can cause the resulting fee to exceed the stated percentage value. A change has

been made to always round down after doing the calculation of the percentage, so the resulting value will never

exceed the calculated amount, even by a fraction of a penny.
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Sales Calculations Now Match in GOLDTrak and eGOLDTrak

CMF# 6404

Sales calculations are done by the eGOLDTrak sales calculator for both eGOLDTrak and GOLDTrak PC. This

ensures that the calculations will always match, whether done in an eGOLDTrak environment or in GOLDTrak

PC. However, up until now, add-on rates were not supported by the eGOLDTrak calculator, so they were

handled separately by GOLDTrak and eGOLDTrak. This has caused some minor differences between the

calculations at times. The eGOLDTrak sales calculator has now been enhanced to support the calculation of

add-on rates, so GOLDTrak PC has been modified to call the eGOLDTrak calculator for add-on calculations

rather than handling it on its own.
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Security Button Now Hidden in Toolbar

CMF# 6257

A correction has been made to the display of the Security Toolbar. Previously, the Security Toolbar menu item

(under View) wasn't displaying a checkmark to indicate whether or not the Security Toolbar was displayed.

Additionally, if a user clicked and dragged the Key button off the screen, it would get lost and not come back. A

checkmark is now displayed to the left of the Security Toolbar menu item when the Key button is displayed. 

The Key button allows users to override a locked loan request. 
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Field Changes

The following changes affect fields in GOLDTrak PC:

Employer Phone Number Transfer to New Phone Record

MSRP Now Transfers to Retail Value

New Field Validation Option

New Transfer Field for Advertising Code
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Employer Phone Number Transfer to New Phone Record

CMF# 6407

GOLDPoint Systems changed the way we save phone records on the host. Each phone record, including

employment phone records, are stored in the FPP0 record (CIF Phone Numbers). Previously, phone records

important to the borrower were recorded in different records. For example, employment phone records were

recorded in the CSEI record (Employment Information Record).

According to this change, GOLDTrak PC now transfers all employment phone records to the FPP0 record when

boarding the loan. This means that you can view and make any additional changes to the employment phone

record using the Customer Relationship Management > Customer Profile screen or Households screen using

the Phones tab in CIM GOLD. 

If a business phone (BUS_PHONE) exists in GOLDTrak PC when the loan is boarded, then the system

transfers that phone record with a Phone Type of Work Phone (type 230). If a supervisor phone exists

(SUPERVISOR_PHONE_I), it transfers that information as Phone Type 226 (Supervisor Phone).

The following is a quick view of where the phone records can be viewed in CIM GOLD in the Phone Type field

after the loan is boarded:
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MSRP Now Transfers to Retail Value

CMF# 6665

The retail value amount (MSRP for vehicles) on collateral is now transferred to the Retail Value field (CFCVAL)

on the Collateral Detail screen in CIM GOLD upon boarding. If the Retail Value field

(PROGRAM_VALUE_LNPD) is not entered in GOLDTrak PC, then the system transfers the Loan Value

(LOAN_VALUE_LNPD) to the Retail Value. Previously, the retail value wasn't transferring, and instead, the

system always transferred the Loan Value to the Retail Value of the collateral item.
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New Field Validation Option

CMF# 6938

You can now establish additional validation on specific fields on your loan applications in GOLDTrak PC. This is

useful if you want to ensure that the data entered by the user is correct. For example, if you add validation to the

Social Security number field, when users enter information in those fields in applications, the system brings up

an additional pop-up that requires the user to enter the information one more time.

To set up additional field validation, a new tab has been created on the Loan Program Design screen in

GOLDTrak PC Setup. The Validation Fields tab is an easy-to-use tab where you select fields on this screen,

and then those fields will automatically require additional validation when entering data in those fields in

GOLDTrak PC.

See the following example of this tab. Notice that the SSN_EIN field is listed on the tab. 

GOLDTrak PC Setup > Loan Program Design Screen, Validation Fields Tab

When users access the loan program in GOLDTrak PC and try changing information in the SSN/EIN field, a

small dialog box appears (as shown below), where the user must re-enter the information. Once the user re-

enters the information, the pop-up box disappears.
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New Transfer Field for Advertising Code

CMF# 6440

A new field, Advertising Code (TF_ADVERTISE_CODE), has been added to the TRANSFER_FIELDS group.

When this field is added to a screen (or formula) in GOLDTrak PC, the information in that field is transferred to

the Advertising field (M1ADVT) in CIM GOLD. This field is found on many screens in CIM GOLD, including the

Loans > Account Information > Additional Loan Fields screen and the Marketing and Collections screen, CIF

tab.
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GOLDTrak PC Setup Changes

The following changes have been made in GOLDTrak PC Setup:

Daily Export of Setup Files

NADA Version Removed from Setup

Regulation O Option Available

UFO Table Correction
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Daily Export of Setup Files

You now have the option of exporting the entire GOLDTrak Setup database, App database, and check database,

as well as any specified record type from any database, on a daily basis. A new afterhours utility is available for

this purpose. This utility exports this file and automatically deletes any existing .txt files with the same name

before outputting the information each night. If the file name is in use or inaccessible, the system adds -2, -3,

etc. to the file name. 

If your institution would like this option, contact your GOLDPoint Systems account manager. This is only

available in GOLDTrak PC Setup version 6.5 and higher.
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NADA Version Removed from Setup

CMF# 6412

Users are no longer required to keep track of the NADA version number for Power Sports. The NADA database

is now maintained by GOLDPoint Systems. This means the Current NADA Version Num field

(NADA_VERSION_IO) has been removed in GOLDTrak PC Setup, Institution/Office Setup screen, Options 2

tab.
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Regulation O Option Available

Regulation O requires notification when a loan is funded for executive officers, principal shareholders, and

directors (and close relatives of those people) at an institution. To accomplish this, we have created a new

screen in GOLDTrak PC Setup, where you can set up officers, along with their Social Security numbers (and

close relatives SSNs). Then, when funding a loan in GOLDTrak PC with a matching SSN from this list, the

system will display a message, similar to the following:

The loan will still be funded, but a note is created on the loan saying, "This may be a Regulation O loan."

Additionally, an email can be sent to a designated person letting them know of the loan funding.

This new screen is found by selecting Design Setup > Regulation O Setup in GOLDTrak PC Setup. You can

either manually enter the information on this screen, or you can import the information from another file, such as

an Excel spreadsheet. The columns in the spreadsheet should be set up as follows:

Name Relationship SSN/TIN

Ricky K Brown Self 123-45-6789

Kimberly P Brown Spouse 123-45-6788

Josh B Brown Child 123-45-6787

This may require assistance from your GOLDPoint System account manager.

See the following example of this screen in GOLDTrak PC Setup:
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UFO Table Correction

CMF# 6767

Opening a UFO Table for editing in GOLDTrak PC Setup and then closing it without making any changes was

causing the FEE_TABLE record to be updated as having been changed by the user. 

This has been fixed, so now when you select a UFO Table for editing and then close without making changes, it

will retain its original Changed By and Changed When information.

UFO Tables are found when you open a loan program from the File > Open Loan Program, then select the Loan

Program, and then access the UFO Tables tab.
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Military Emails Now Accepted

CMF# 7193

Military emails are now accepted in GOLDTrak PC. Previously, they were rejected due to the rules we had set

up for verifying emails. Military emails contain two periods (.) after the at (@) symbol, such as

first.last@us.army.mil, and the rules restricted emails with more than one period after the at symbol. That rule

has been discontinued.

For your review, theses are the rules for acceptable email addresses:

1. Must contain only one "@"

2. Must contain 2-4 characters after the final "."

3. Must not begin with "."

4. Must not contain illegal characters: & : / ; # , or space

5. Must not contain ".."
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Recurring ACH Payments Changes

CMF# 6482, 6667, 7456

The following enhancements have been made to recurring ACH payments:

· The Recurring ACH Payments screen has been corrected to only allow 17 characters to be entered in the

Account Number field. The prevents the error message "Enter no more than 17 characters" from appearing.

Also, the same type of problem was fixed in the Additional Names dialog. Now, the user is prevented from

entering more than 45 characters (maiden name) or 35 characters (all others), which prevents error

messages.

· The code to restrict the payment start date to a weekday if the payment cycle was set to bi-weekly was

removed.

· Payment cycle options "Cycle Semi-monthly" and "Cycle Bi-weekly" have been removed from the Payment

Cycle/Frequency field.

· New fields can now be added to the Recurring ACH Payments record (FPRA). These fields transfer to the

CIM GOLD recurring ACH record, which can be viewed on the Loans > Account Information > Payment

Information screen.

Some of these fields are initially hidden on the Recurring ACH Payments screen in GOLDTrak PC, but can

be unhidden during formula processing. These fields are:

· Recur ACH Ovrd Pmt (TF_RECUR_OVRD_PMT) transfers to the Override Payment Amount field

(RAREQA) in CIM GOLD.

· Recur ACH Fee Amt (TF_RECUR_FEE_AMT) transfers to the Fee Amount field (RAFAMT).

· Recur ACH Pmt Freq (TF_RECUR_PMT) transfers to the Frequency field (RAFREQ).

· The Payment Cycle/Frequency field contains many fields in GOLDTrak PC. What you select in this

field transfers to different fields in CIM GOLD. For example, if the "Cycles on Nth" is selected, then that

data is transferred to the Cycles on field (RAPCYC) in CIM GOLD. If "Cycles on Due Date" is selected,

then the Cycle By Due Date box (RABYDU) is checked. The Payment Cycle/Frequency field is

always displayed on the Recurring ACH Payments screen in GOLDTrak PC.

In order to show the other fields, three additional new fields have been added to the field database in the

LOAN_REQ_MISC7 group:

· SHOW_RECUR_FEE_AMT

· SHOW_RECUR_OVRD_PMT

· SHOW_RECUR_PMT_FREQ

· When setting up accounts on the Recurring Payments screen in GOLDTrak PC, after the loan is boarded

the information now transfers to both the Payment Information screen and the External Accounts screen in

CIM GOLD. Previously, the recurring payment information was only being transferred to the Payment

Information screen, Loan Information tab, Recurring field group (also know as the FPRA record). The

External Account screen can be accessed in many places in CIM GOLD, including the External Accounts
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link on the EZPay screen and a special tab called ACH Accounts (FPEA) on the Payment Information

screen.

Recurring ACH Payments Screen in GOLDTrak PC
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Loans > Account Information > Payment Information Screen in CIM GOLD
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External Accounts Record (FPEA) in CIM GOLD
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Screen Changes

The following screen changes and enhancements have been made in GOLDTrak PC previous to version 7.1:

Enhancements to Ancillary Insurance

Enhancements to Vehicle Information

Fields added to Borrower/Co-Borrower Income Screen

KarPower Screen No Longer Crashes

Kelley Blue Book Info Driver Now Uses ZIP

Marital Status Removed from 1003 III & V Screen

New AD&D Screen

New Documents Utility

New Energy Loan Information Screen

New HMDA Reporting Screen

New Kelley Blue Book Vehicle Screen

New NADA Vehicle Value Screen

New NADA Warning Message

New Pop-up Screens for Budget, CIP

New Vehicle Information Screen

Pop-up Version of Vehicle Information
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Enhancements to Ancillary Insurance

CMF# 6256

On the Ancillary Insurance dialog, support has been added for the following insurance types:

· Involuntary unemployment (both single and joint)

· Personal property (regular, dual, and dual protected)

· Auto (VSI, ASI, LPD, and Collateral Plus)

The Ancillary Insurance dialog box also refreshes and displays new data when any formulas are changed that

affect this dialog box.
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Enhancements to Vehicle Information

CMF# 6392

The following features have been added to the Vehicle Information, NADA Vehicle Information, and Kelley Blue

Book Vehicle screens. 

1. The list control at the top of each of these screens can now be filtered to only show NADA-certified

vehicles or Kelley Blue Book-certified vehicles. To filter the list control, new check boxes and radio

buttons have been added underneath the list control. 

2. You can signify which vehicles are NADA-certified verses KBB-certified by selecting the applicable

checkboxes that have been added to the screen. On the Vehicle Information screen, the checkboxes are

Uses NADA and Uses Kelley Blue Book. On the NADA Vehicle Value and Kelley Blue Book Vehicle

Value screen, the check boxes are NADA Vehicle and Kelley Blue Book Vehicle. 

3. On the Vehicle Information screen, a new Values list control has been added to the bottom of the screen.

This list control displays the value of the vehicle as added from either the NADA Vehicle Value and Kelley

Blue Book Vehicle Value screens. With the proper setup, users can edit those values by clicking

.

See the following examples of these new features on the Vehicle Information screen and NADA Vehicle Value

screen. The Kelley Blue Book Vehicle screen is not pictured below, but it is similar to the NADA Vehicle Value

screen.
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Vehicle Information Screen
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NADA Vehicle Value Screen
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Fields added to Borrower/Co-Borrower Income Screen

CMF# 6326

The following fields have been added to the Borrower/Co-Borrower Income screen. 

· A Best Time to Call field (BEST_CONTACT_TIME_I) has been added in the Employer/Income Provider

Contact Information section. This field can be hidden. (GOLDPoint Systems: To hide the field, set the

EMPL_SHOW_BEST_CNTC in group LOAN_REQ_MISC7 to false.)

· A Pay Day of Week field (PAY_DAY_WEEK_I) has been added in the Income Information section. This

field may be hidden until a user selects "Weekly" from the Payday Frequency field. This field can also

be hidden completely. (GPS: This field is hidden if EMPL_SHOW_PAY_DAY_WK in the

LOAN_REQ_MISC7 group is false, or if the record is for a previous employer (sequence 2-5).

· A Next Day field (NEXT_PAY_DATE_I) has been added in the Income Information section. The field is

hidden if EMPL_SHOW_PAY_DATE is false, or if the record is for a previous employer (sequence 2-5).

The Income screen is usually accessed from the CIF Compare screen, Employment tab, then click

 at the bottom of the screen. See the following example of this screen with the new fields

highlighted below.
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KarPower Screen No Longer Crashes

CMF# 6198

We have corrected the problem that caused KarPower to crash when opening in GOLDTrak PC version 5.1. It no

longer crashes.
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Kelley Blue Book Info Driver Now Uses ZIP

CMF# 6391

The previous version of Kelley Blue Book InfoDriver only works through the end of 2012. These changes support

the new 3.0 version. Kelley Blue Book 3.0 now uses ZIP codes instead of states/region. See the following

example of the Kelley Blue Book InfoDriver screen highlighting the new Zip Code field.
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Marital Status Removed from 1003 III & V Screen

CMF# 6726

The Marital Status field has been removed from the 1003 III & V screen. In its place, we have added the

<Additional Information> button. Clicking this button brings up the Borrower Additional Information screen, which

allows the user to set a number of fields about the borrower.

The Borrower Additional Information pop-up screen was also changed slightly. The screen will be a smaller size

if the References section, which occupies the bottom half of the screen, is hidden.

See the example below of the <Additional Information> button and the Borrower Additional Information pop-up

screen.

1003 III/V Screen
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Borrower Additional Information Pop-up Screen
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New AD&D Screen

A new AD&D Policies screen is now available in GOLDTrak PC. This screen allows you to set up Accidental

Death and Dismemberment policies tied to this loan. If you check the Board box, this information will transfer to

the CIM GOLD system when the loan is boarded. The policy information can be viewed on the with the loan. You

can view the policy on the Loans > Insurance > Policy Detail screen in CIM GOLD.

If you are interested in adding this screen to any of your loan programs, contact your GOLDPoint Systems

account manager. The following is an example of this screen:

AD&D Policies Screen
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New Documents Utility

CMF# 6258

A new utility has been added to GOLDTrak PC to view blank documents. It is access by selecting "Documents"

from the Utility menu. The Document utility has the following features:

· All document records for your institution are shown in a tree view.

· You can filter the documents by choosing any of the following: all documents, dhow document sets

only, and show documents from a particular loan program.

· The documents can be sorted by any of the following: document ID (default), changed date (descending

order), or document name.

· You can also use the Search field and button, and it will find any matching text in the tree.

· Document sets display a child node for each document contained in the set. (The same document can

appear multiple times in the tree.)

· When a document is highlighted, the document record appears in the list control at the bottom of the

dialog. This allows the user to see more of the details. Also, the user can right-click on the document in

the list control and select "View Document Data" to view the entire record.

· When the user checks/unchecks a document set, all subdocuments are automatically

checked/unchecked too.

· When the user unchecks a child document, the document set is automatically unchecked too.

· The <Print> button prints all checked documents. If no documents are checked, it will print the

highlighted document.

· The <Preview> button shows a preview of the highlighted document.

· During preview mode, the Document utility dialog will disappear; it will reappear when the preview

window closes.

See the following example of this utility:
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New Energy Loan Information Screen

We have created a new programming screen for energy loans. Energy loans often times involve a partnership

with a participating power or gas company. Energy loans are for improvements on energy performance in a

home or business.

This screen includes fields for a contractor responsible for making the energy improvements, fields for an auditor

assigned to this loan application, the ability to add information on the improvement being made to the home, the

utility information of the company involved with this loan, and the cost of the project. This new screen requires

some setup by your GOLDPoint Systems account manager. 

The following is an example of this screen:

Energy Loan Information Screen
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New HMDA Reporting Screen

A new HMDA reporting screen is now available. This screen, HMDA Data Entry screen, replaces the outdated

HMDA screen. This screen has been updated to match the requirements set out by the Federal Financial

Institutions Examination Council. Information entered on this screen is for Home Mortgage Disclosure Act

reporting purposes. For more information concerning HMDA reporting, see the FFIEC website.

HMDA Data Entry Screen

http://www.ffiec.gov/hmda/guide.htm
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New Kelley Blue Book Vehicle Screen

CMF# 6259

A new screen, Kelley Blue Book Vehicle, has been created. This screen differs from the old Kelley Blue Book

InfoDriver screen as follows:

1. It stores the data in VEHICLE_INFO rather than CONSUMER_DETAIL.

2. It can handle an indefinite number of vehicles.

3. It can store an unlimited number of equipment options per vehicle.

At the top of the screen is a list control that displays all existing VEHICLE_INFO records containing Kelley Blue

Book data. Selecting one of these vehicles will fill in the fields with that vehicle's data.

To add a new vehicle, simply click <New>, or just start adding data when a vehicle is not selected in the list.

To delete a vehicle, click <Delete>.

See the following example of this screen:
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See also:

New NADA Vehicle Value Screen

New Vehicle Information Screen
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New NADA Vehicle Value Screen

CMF #6178

A new programmer screen, NADA Vehicle Value screen, has been added. This screen allows you to quickly

enter vehicle information, as well as look up the NADA value for the vehicle. It is identical to the NADA Car

Value screen, except with the following enhancements:

1. A list control is displayed at the top of the screen containing any vehicle records (VEHICLE_INFO)

already entered on the selected application. If a vehicle is not listed in this list view, and it should be

there, try selecting the Show All Vehicles radio button. If the NADA Vehicle box is not checked, then it

will not be displayed in this list view if the Show NADA Vehicles Only radio button is selected.

Double-click a vehicle in the list control to make changes to any of the information.

This list control replaces the <Car 1> and <Car 2> buttons that were displayed on the bottom of the

NADA Car Value screen.

2. <New> and <Delete> buttons have been added to the bottom of the screen. 

· Clicking <New> allows you to create a new vehicle record for this application. By default, the NADA

Vehicle box is checked. 

· Selecting a vehicle in the top list view and then clicking <Delete> will delete the vehicle record from

the account.

3. You can print a new document from this screen that details the NADA value of the vehicle. If this

document is not set up for your institution, the <Print> buttons are not displayed at the bottom of the

screen.

Any vehicle information entered on this screen transfers over to the Assets screen of the Application, as well as

to the new Vehicle Information screen.

See the following example of this screen:
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NADA Vehicle Value Screen
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New NADA Warning Message

CMF# 6675

You can now establish a warning message that is displayed any time a user exits the NADA Vehicle Value

screen or the NADA Car Value screen (depending on which screen your institution uses) in GOLDTrak PC. This

message can be used to ensure that all information entered is complete and accurate, or refer users to a phone

number of someone they can call if they have questions, as shown below.

This is an optional message.

If you would like this message to appear, complete the following steps:

1. Access the Options 2 tab of the Institution/Office Setup screen in GOLDTrak PC Setup. 

2. Check the Show Message on Exit checkbox.

3. Click the <Edit> button. A dialog box pops up to allow you to enter the text on the message.
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New Pop-up Screens for Budget, CIP

We have added two buttons to the bottom of the Consumer Application screen:

·  - Click this button to quickly access the Budget dialog box, where you can set up a new

budget for the borrower, and view what the Debt to Income Ratio will be after the loan is funded. This is

a handy tool to quickly calculate for the borrower what type of impact the loan will have on their budget

(as shown below).

·  - Click this button to open the CIP/Discrepancy Resolution dialog box. Use this dialog

box to enter additional information that will help verify that the borrower is who they say they are. CIP

stands for Customer Identification Program, and some examiners require additional identification

verification of customers. This dialog box will help meet that requirement.
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New Vehicle Information Screen

CMF#6154

A new Vehicle Information screen is now available that allows you to enter vehicle information tied to the loan.

Vehicles include automobiles, boats, motorcycles, or other titled vehicles. The list box at the top of the screen

displays all existing vehicle records already entered for this borrower.

Click <New> to create a new vehicle record. If you want to see if the VIN has already been entered on the

system, enter the number in the VIN # field and click <VIN Lookup>.

This screen has the following optional features:

1. If your institution uses NADA (Uses NADA box is checked on the account), the NADA-specific trade

values and buy/sell values are displayed (after you click <Edit Values>) at the bottom of the screen. If

your institution uses Kelley Blue Book, fields specific to Kelley Blue Book are displayed in the Values

box.

2. You can add title information to this vehicle by clicking <Title Info>. 

3. You can also add insurance information by clicking <Insurance>. 

4. If the Uses NADA box is checked, the <Equipment> button is displayed. Click that button to view all

NADA equipment options tied to that vehicle.

5. If your institution wants links to other useful websites, those can be entered at the bottom of this screen.

See the following example of this screen with the options highlighted:



GOLDTrak What's New60

© 2019, GOLDPoint Systems. All rights reserved.Last updated: 5/13/2019

You will need to contact your GOLDPoint Systems account specialist if you want this screen added to any

application. Also, we can add a <Vehicle Info> button to any screen, which accesses this screen as a pop-up.

See the Pop-up Version of Vehicle Information topic for more information.

GOLDPoint Systems Only:

If there are any VEHICLE_URLS records that go with the selected vehicle, a label called Links will appear

at the bottom of the screen, and beneath it will be hyperlinks that can allow the user to go to a website.

Each link can optionally have a description above it (URL_DESC_VU) and/or a label that appears in place

of the actual URL (URL_LABEL_VU). The number of URLs is unlimited, and the screen will allow the user

to scroll down to the bottom of the links if they are not all visible on the screen.
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If REQUIRED_FIELDS_VI contains any text, its contents will appear in red at the bottom-right of the

screen under the label "Required Fields."

If field SHOW_TITLE_BTN_VI is true, the <Insurance> button will appear on the screen. Clicking this

button will bring up the Auto Insurance dialog. If there is an AGREE_PROVIDE_INS record that

corresponds to the selected vehicle, that record will automatically be selected when the dialog comes up.

See also:

New NADA Vehicle Value Screen

New Kelley Blue Book Vehicle Screen

Pop-up Version of Vehicle Information
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Pop-up Version of Vehicle Information

The Vehicle Information screen is also available as a pop-up screen from any screen in GOLDTrak PC. We can

place a button on a screen named <Vehicle Info>, and users can click that button to access the Vehicle

Information screen as a pop-up.

The pop-up screen is identical to the Vehicle Information screen, except if you include many URL links to

outside websites, users may need to increase the size of the pop-up window rather than scroll to the bottom.

There is no scroll bar on the pop-up version.

If you would like this button and pop-up screen added to your loan applications, contact your GOLDPoint

Systems account manager for more details.

GOLDPoint Systems Only: The mapping record for the pop-up screen is IDD_VEHICLE_INFO_POPUP.
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